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How to…
■ Create a slide show to show off your images

■ Post your images in web pages

■ Build cards, calendars, and postcards

■ Create photo albums

■ Burn a CD

Now that you’ve gone to all the trouble of importing,

cataloging, and tagging your photos, wouldn’t it be great

to use them? Chapter 24 talks about printing, but there is far

more you can do with your photos. You can create web pages,

create calendars and postcards, and burn a CD to share with

friends and family. You can even package the images up into

an Adobe Acrobat Presentation!

Start the Creation Process
The collection of items you can build is referred to in Organizer

as a creation. To start the process of building a creation, you can

use one of the following options:

■ In Organizer, choose File | New | Creation This opens

the general Creation Setup dialog box (see Figure 25-1).

■ Click the Create button in the Organizer shortcut

bar This also opens the Creation Setup dialog box.

■ Choose File | New in Organizer and pick the type of

creation from the menu This action bypasses the

Creation Setup dialog box and jumps straight to the first

page in the appropriate Create dialog box.

■ In the Editor, choose File | New | Creation This

switches to Organizer and opens the Creation Setup

dialog box.
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To continue, pick one of the creations listed along the left

border and click OK to start the process. The appropriate dialog

box loads, and after a few moments you are ready to start the

creation process!

Build a Slide Show
To build a slide show, select Slide Show from the Creation

Setup dialog box or choose File | New | Slide Show. From here,

you can choose to build either a custom slide show or a simple

slide show.

Build a Custom Slide Show
A custom slide show essentially creates a movie, complete with

a music track, transitions, recorded annotations, and text. To

FIGURE 25-1 Use the Creation
Setup dialog box to pick the type
of creation you want to build.
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start building a custom slide show, select Custom Slide Show

from the slide show Creation Setup dialog box and click OK to

display the Slide Show Editor dialog box (see Figure 25-2).

Slide show
play controls

Add images from
Organizer or folders

Add audio from
Organizer or folders

Record a narration
for the current slide

Click to add music
track (audio)

Click to add photos
to the slide show

Zoom controls

FIGURE 25-2 Build your entire
custom slide show right from the
Slide Show Editor dialog box.
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25Set the Custom Slide
Show Preferences
To set the defaults for a custom slide

show, choose Edit | Slide Show Preferences

to display the Slide Show Preferences

dialog box, shown here.

This dialog box enables you to set

values to use for the default slide duration

(Static Duration), the between-slide

transition, the transition duration, the

background color (useful for blank slides),

and whether to include the photo captions

as text and the audio captions as narration.

One of the options you

can use when you save your

slide show is to save it as a

Windows Media Video file

(WMV). To specify the

default quality for the WMV

file, click the Change WMV

Output Quality button to

open the dialog box shown

at left, in which you can

set the quality of the file.

Simply select one of the quality options in the drop-down list.

Add Pictures to Your Slide Show
The easiest way to add pictures to the slide show is to have

them selected before you start the creation. If you do have them

selected, the list of images appear in the bottom third of the

Slide Show Editor dialog box, as shown in Figure 25-3.

If you don’t select your slides before starting the custom

slide show, you’ll have to click the area below the play controls

(marked Click Here to Add Photos to Your Slide Show). You

can also choose Add | Photos from Organizer, or click the
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Add Photos tool in

the shortcut bar and

select Add Photos

from Organizer.

Any of these actions

opens the Add Photos

dialog box, shown here.

To add an image to

the slide show, click the

check box alongside

the image. Click it again

to clear it if you change

your mind.

Slides in the
slide show

Transition
between slides

Timing for
each slide

Timing for each
transition

FIGURE 25-3
If you select your
images before
starting the custom
slide show, they
will all appear—
complete with the
default transitions
and timing.
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The area at the left side of the dialog box (Add Photos

From) configures which photos are available for you to choose

on the right side of the dialog box. The options are as follows:

■ Photo Browser Displays the thumbnails currently

visible in the Photo Browser. If you have created a set

of search results, only those thumbnails will be visible

in the dialog box.

■ Entire Catalog Displays all the thumbnails in the

currently open catalog, whether or not they are visible

in the Photo Browser.

■ Collection Displays only the images associated with

the collection you choose from the drop-down list.

■ Tag Displays only the images associated with the

tag, category, or subcategory you pick from the drop-

down list.

■ Photo Bin If you have any images open in the Editor

Photo Bin, pick this option to display just those images

in the dialog box.

■ Show Favorites Only If you select the Show Favorites

Only check box, only the images that meet the criteria

you set and have been tagged with one of the Favorites

tags will be displayed.

■ Show Hidden If you select the Show Hidden check

box, only the images that meet the criteria you set and

have been tagged as Hidden will be displayed.

Once you select a set of photos by checking the thumbnails,

click Add Selected Photos to add the selected photos to the slide

show. This action clears the check boxes and leaves the Add

Photos dialog box open so you can change your options and

pick another set of photos to add to the slide show. When you’re

done adding photos, click OK to close the dialog box and display

the Slide Show Editor, as shown previously in Figure 25-3.
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25To select or clear a check box, you don’t actually need to click the check box. Simply

click the image thumbnail.

If you decide you need to add more photos, simply click Add | Photos from Organizer

to repeat the process.
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Another way to add photos is to choose Add | Photos from

Folder or click the Add Photos tool in the shortcut bar and

choose Add Photos from Folder. Either opens a standard File

Open dialog box (labeled Choose Your Photo Files). Navigate

to the file(s) you want to add, select them, and click Open.

Remember that you can select multiple files at once using

CTRL-click and SHIFT-click.

Rearrange the Slides
After you get done picking your images, you can rearrange

them. To do so, click the image you want to move and drag the

image to its new position in the slide show. As you drag, a

vertical line appears to show you where the image will be placed

when you

release the

mouse button.

Release

the mouse

button when

you have

the slide

positioned

properly.

Duplicate and Delete Slides
It can be handy to display the same slide more than once. For

example, you might wish to use a particular slide at the beginning

of different sections of the slide show, perhaps with different

text to introduce the section (for more on text, see the section

“Add Text to a Slide,” later in this chapter). To duplicate a slide,

select the slide thumbnail and choose Edit | Duplicate Frame.

You can also duplicate a slide and place it where you want it

by using the following steps:

1. Choose the slide thumbnail you want to duplicate.

2. Select Edit | Copy.

3. Choose the slide thumbnail after which you want to

place the duplicated slide.

4. Select Edit | Paste. The slide is inserted into the slide

show following the slide you selected in step 3.

To delete a slide, select the slide thumbnail and choose Edit |

Cut or Edit | Delete Frame.

P:\010Comp\HowTo8\805-5\web.vp
Friday, December 03, 2004 2:52:17 PM

Color profile: Generic CMYK printer profile
Composite  Default screen



Set the Transitions Between Slides
You can specify a transition to occur between any

two slides. These transitions create an interesting

effect, although they should not be overused

because they can become tiresome.

To set an individual transition, click the transition

box between the two slides and pick the transition

you want from the pop-up list (shown at left).

If you want to apply the transition to all the

slides, pick Apply to All from the transition pop-

up list or choose Transitions | Apply Transition to

All. You can also set the transition to the default

by picking Set to Default from the transition pop-

up list. Finally, you can also choose the default

transition from the Slide Show Preferences dialog

box (select Edit | Slide Show Preferences).

The Transitions menu also has two options to

remove transitions:

■ Clear Transition Removes the current

transition. This has the same effect as

selecting None from the transition pop-up list.

■ Clear All Transitions Removes all

transitions and sets them

back to None.

Set the Timing for
Slides and Transitions
To set how long the transition

should take (keep it short!), click

the transition duration pop-up

list below the transition and pick

the transition duration.

The list includes entries

from 2 seconds (2s) to 5 seconds (5s) as well as a Custom entry.

To set a custom transition duration, click the Custom entry and

type the number of seconds into the Set Transition Duration

dialog box. Then click OK.

CHAPTER 25: Build Creations with Your Photos 9
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To set all the transition durations to the same length, first set the transition to the

length you want. Then click the transition duration pop-up list again and pick the

topmost entry in the duration drop-down list: Set All Transitions to 2s (or whatever

length you had picked).
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To set how long a slide should be shown, click the slide

duration pop-up list below the slide and pick the slide duration.

This list includes all the same options as the transition duration,

including setting all slides to the currently selected duration.

You can also set an individual slide duration by choosing Edit |

Change Slide Duration, filling in the duration in the dialog box,

and clicking OK.

Add an Audio Track to the Slide Show
It can be a lot of fun to add a music track to a slide show, although

you should be careful that the music agrees with your intended

audience. To add an audio track to the slide show, click the bar

that reads Click Here to Add Audio to Your Slide Show or

choose Add | Audio from Folder. Alternatively, you can pick

Add Audio from Folder from the Add Audio

tool in the shortcut bar. Any of these actions

opens the Choose Your Audio Files folder.

Simply pick the music track you want to use

and click Open. The name of the audio file

appears in the bar below the slides.

If you’ve added sound files to Organizer,

you can pick a file from the open catalog.

Choose Add | Add Audio from Organizer (or

pick Add Audio from Organizer from the

Add Audio tool in the shortcut bar). The Add

Audio dialog box displays all the sound files

in Organizer—just pick one and click OK.

Once you’ve added a music track, you can fit the slide

show to the length of the music by clicking the Fit Slides to

Audio button in the lower-right corner of the slide preview area

or choosing Edit | Fit Slides to Audio. You can also edit the

audio by double-clicking the audio bar (below the slides) or

selecting Edit | Edit Audio. This opens the Edit Slide Show

Audio dialog box, shown on the next page.

10 How to Do Everything with Photoshop Elements
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If you click the Browse button in the Add Audio dialog box, the Import Audio dialog

box opens. To import audio into the catalog, select an audio track (you can pick only

one at a time) and click Open. However, each track you import this way is also added

to the slide show.
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25The Edit Slide Show

Audio dialog box provides

the following capabilities:

■ Add audio You can

add additional audio

tracks by clicking the

Add Audio button.

This re-opens the

Choose Your Audio

Files dialog box, where

you can select more

audio tracks. When you

are done picking the

additional tracks, click

Open to add them to

the list in the Edit Slide

Show Audio dialog

box. The tracks are

added in the order you

picked them and placed

immediately after the track you selected prior to adding

the audio tracks.

■ Add a gap To add a gap (a silent section), click the

Insert Gap button. This inserts a gap immediately after

the selected track. The default gap length is 5 seconds.

To change the length of the gap, click the Gap entry in

the dialog box and adjust the Length field.

■ Delete an audio track To remove an audio track

(or a gap) from the list, select the track and click the

Delete button.

■ Rearrange the audio tracks If you have multiple

tracks in the dialog box, you can click and drag them

to rearrange their order.

■ Adjust the length of the track If you want to truncate

one of the tracks (including a gap), set the Length spinner

to a value less than the actual length of the track. You

cannot make the track longer than the actual length.
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■ Set the volume of each track You can individually

adjust the volume of each track. To do so, select the

track and use the Volume slider. To preview the track

at the selected volume, click the Play button.

■ Repeat Music Until Last Slide If the total length

of the audio track is shorter than the slide show, the

balance of the slides will play in silence unless you

select the Repeat Music Until Last Slide check box. In

that case, the audio track will repeat until the end of

the slide show.

Add an Audio Caption to a Slide
If you’d like to add narration for a slide, choose Add |

Narration, select Narration from the slide thumbnail

shortcut menu or click the Add Narration for the

Current Slide Tool in the shortcut bar. Any of these

actions opens the Edit Narration dialog box, at right.

To use the audio caption for the photo, select the

Use Photo Audio Caption option and click OK. If

you’d like to record your narration or choose a file to

use for the narration, click the Edit Audio Caption

button. This opens the Select Audio File dialog box,

shown here.

Here you can choose a file (File | Browse) or

record a narration by clicking the red Record button

(just to the left of the Play button). When you’re done

recording, click the Stop button (just to the right of

the Play button). Choose File | Close and click the Yes

button when prompted to save the new audio caption.

Slides with a narration display a small speaker icon in

the lower-right corner.

12 How to Do Everything with Photoshop Elements
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The Start Time field refers to where in the currently selected track the audio should

start. A value of 00:00 refers to the beginning of the audio. If you adjust the start time

with the spinner, the length automatically adjusts so that the sum of the start time and

the length equals the total length of the audio track.

To remove the narration from the slide, re-open the Audio Caption dialog box (which

now indicates the filename of the narration file in the title bar) and choose Edit |

Clear. Then select File | Close and click the Yes button when prompted to save the

new audio caption.
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Add Text to a Slide
You can add text to label a slide. To do so, select

Add | Text, choose Add Text from the Slide

Thumbnail shortcut menu, or click the Add Text

tool in the shortcut bar. Any of these actions opens

the Edit Text Properties dialog box, at left.

Type the text you want into the field and choose

the typeface, effects, and font size from the three

drop-down lists. You can also choose the alignment

(left, center, or right), and change the text

orientation to either horizontal

(the default) or vertical using

the buttons just above the text

field. Finally, you can change

the text color by clicking the

color box (just to the right of

the text orientation button) and

picking a color from the Color

Picker.

Click OK to place your text

on the image, as in the example

at left.

Once your text is visible on

the slide preview, you can move

it by clicking the text and

dragging it to a new location.

Add a Blank Slide
For titling purposes, it can be useful to insert a blank slide into

your presentation. To do so, select the thumbnail after which

you want the blank

slide, and select

Add | Blank Slide

or click the Blank

Slide button in

the shortcut bar.

The blank slide is

inserted into the

slide show, as you

can see here.

25
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To edit your text, choose Edit | Text to redisplay the Edit Text Properties dialog box.
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To change the color of the slide, choose Change Background

Color from the blank slide shortcut menu or select Edit |

Change Background Color. Then pick the color from the Color

dialog box.

Preview and Save the Slide Show
The controls just below the image preview in the Slide Show

Editor dialog box enable you to move through your slides and

preview them in the dialog box. Click the big Play button (the

third button from the left) to start the slide show. Click the Pause

button (the Play button turns into a Pause button during playback)

to pause the show, or click the Stop button (third from the right)

to stop the show. The rest of the buttons enable you to navigate

through the slides.

Once you’re happy with the slide

show, it’s time to save it. Select File |

Save As (or File | Save the first time

you save) to see the dialog box at right

where you can name your creation.

Type in the name of the slide show

and click Save to save it. The slide

show shows up in the current catalog

(with today’s date). The catalog

displays a thumbnail of the first slide

and a special icon to indicate that the thumbnail represents a

creation (in this case, a slide show), as in the example at right.

14 How to Do Everything with Photoshop Elements
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As with any other slide, you can choose a duration, specify transitions, add text, and

add narration to blank slides.

To preview the slide show full-screen, click the Full Screen Preview button in the

upper-right corner of the dialog box, or choose File | Full Screen Preview. Press the

ESC key to end the full-screen preview and return to the dialog box.
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25Alternatively, you can choose File |

Done to see a slightly different dialog box,

shown at left. This dialog box enables you

to save the slide show as well as output it as

a Windows Media Player video (WMV) so

that anyone with a copy of Windows Media

Player can view your slide show. The first

step is to fill in the name of the slide show

and click Save. Photoshop Elements saves

the slide show and then provides a dialog

box (shown at left) where you can change

the WMV output quality if you wish.

Save the WMV file using the following

steps:

1.To change the WMV output quality,

click the Change WMV Output Quality

button, pick the quality you want from the Choose

Profile dialog box, and click OK. This returns you to the

previous dialog box.

2. Click OK in the dialog box and Photoshop Elements

prompts you for the name of the Windows Media

Player file with a standard Save As dialog box.

3. Fill in the filename and click Save. The result is a

Windows Media Player video.

Edit a Slide Show
Once you’ve saved a slide show, you can re-open it in the Slide

Show Editor. To do so, select the thumbnail for the slide show in

If you are going to burn the slide show to a video CD, choose either VCD NTSC Output

or VCD PAL Output (depending on which format you need for your TV). If you are

going to burn the slide show to a DVD, choose DVD NTSC Output or DVD PAL Output.

If you choose File | Done after choosing File | Save, the slide show dialog box closes

without giving you the opportunity to save the slide show as a WMV. Thus, if you’ve

already saved the slide show using File | Save, you can save a WMV version by

choosing File | Output as WMV, which walks you through all the steps to pick the quality and

provide a name for the WMV file.
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the catalog and choose Edit from either the thumbnail shortcut

menu or the Edit menu.

If you neglected to output the slide show as a WMV, you can

do that, too. Choose Output as WMV from either the thumbnail

shortcut menu or the Edit menu, and follow the previously

discussed prompts to set the quality, assign a filename, and

output the file.

Finally, you can view the images included in the slide show

in Organizer. To do so, choose Show Creation Items in Photo

Browser from either the thumbnail shortcut menu or the Edit

menu. The thumbnails for the included images are displayed,

and you can edit them if you wish. Click the Back to All Photos

button to return to viewing all the thumbnails in the Organizer.

Burn the Slide Show to a Video CD
You can burn a slide show to a video

CD (VCD) directly from the Slide

Show Editor. To do so, choose File |

Burn a Video CD. This opens the

Burn dialog box, at right.

If you have more than one drive

capable of burning a CD, pick the

one you want to use from the Select

Destination Drive section of the

dialog box. You’ll also need to select

whether to use NTSC or PAL by

picking the appropriate option in the

Select Video Format section. Finally,

you can pick the drive speed from the

Select Drive Speed drop-down list.

When you are done picking these

options, make sure you have a blank,

recordable CD in the drive and click

OK to burn the video CD. The Status

bar shows the progress of the burn

as a WMV (Windows Media Video)

file is created and written to the CD.

After the burn is complete, you can

remove the CD from the drive.

16 How to Do Everything with Photoshop Elements
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Once you save a slide show, you can choose to burn a video CD from the shortcut

menu. Just pick Burn a Video CD to open the Burn dialog box and follow the prompts.
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Build a Simple Slide Show
The other option in the Creation Setup dialog box for a slide

show is the Simple Slide Show. This option packages up your

images into an Adobe Acrobat (PDF) file that anyone with the

free Acrobat Reader can view.

To get started creating a Simple Slide Show, select Simple

Slide Show from the slide show Creation Setup dialog box and

click OK to display the Simple Slide Show dialog box:

To add photos, click the Add photos button in the button bar

along the top of the dialog box. This opens the same Add Photos

dialog box that the custom slide show uses.

CHAPTER 25: Build Creations with Your Photos 17
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To obtain a copy of the Acrobat reader software, go to www.adobe.com.

As with the custom slide show, if you select a set of pictures before starting the simple

slide show, the pictures will appear in the Simple Slide Show dialog box when it opens.
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Once you’ve added images to the slide show, they are

displayed in the central area of the dialog box with a number

that shows the order in which the slides will be displayed:

Using the buttons and the central area containing the image

thumbnails, you can:

■ Rearrange the images Drag and drop the images to

rearrange them.

■ Use a picture more than once To use a picture more

than once, select the picture and click the Use Photo

Again button. This duplicates the image so you can

drag and drop it where you want the duplicate.

■ Discard a photo Select a thumbnail and then click

Remove Photo to remove the photo from the slide show.

■ Change the thumbnail size Use the Thumbnail Size

drop-down list to change the size of the thumbnail.

This does not affect the size of the image in the final

slide show.

18 How to Do Everything with Photoshop Elements
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You can use the options in the lower-left corner of the Simple

Slide Show dialog box to pick a transition and the amount of

time (duration) to show each slide. Unless you pick the Random

Transition, the same transition is used for each slide. You can

also choose whether to repeat the slide show (select the Loop

After Last Page check box) and whether to view the slide show

after saving it.

Finally, you can set the size of the images in the slide show

from the Photo Size drop-down list. Depending on what you are

going to use the slide show for, you can choose one of the common

screen sizes (such as 1024 × 768 pixels), leave the photos at their

original size (Original), or choose a custom size. If you choose

Custom, you can type in any size you want in pixels in the Custom

Photo Size dialog box. If you do choose to change the size, you

can pick the quality of the resulting image. A low-quality image

creates a smaller file for the slide show. A higher quality setting

creates better pictures but the file can be much larger.

To save the simple slide show, click the Save button, fill in

the filename in the Save Simple Slide Show dialog box, and

click Save.

Build Photo Album Pages
You can build a set of photo album pages to display your

images. You can choose how many images to show on each

page, whether to show text captions, and even pick from a wide

choice of page styles. You can also rearrange and size photos

on each page. When you’re done, you can print them yourself

or have them professionally printed.

Set Up the Photo Album Pages
To start the process of creating a set of photo album pages,

select Photo Album Pages from the Creation Setup dialog box

CHAPTER 25: Build Creations with Your Photos 19
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Setting the image size will scale the image until one dimension fills the available

screen. The slides will not be distorted. If some of the pictures are small, however,

they will be scaled up to fit the specified dimension, which could leave them looking

very “pixely.”
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and click OK to display the Create Photo Album Pages dialog

box (see Figure 25-4).

The first thing you need to do is to set the basic configuration

of the photo album pages. Use the following steps:

1. Use the scrolling list of styles on the right side of the

dialog box to pick the style of album page you want,

and click the style. A preview appears in the center

of the dialog box.

2. Use the check boxes at the bottom of the dialog box to

decide whether you want a title page, captions, page

number, a header, and a footer.

3. Pick the number of photos per page from the Photos per

Page drop-down list. Some of the options alternate the
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Choose a style of photo page

Choose what you want on each page Choose how many images
to show on each page

FIGURE 25-4 Build professional-
looking photo pages with the Create
Photo Album Pages dialog box.
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number of photos on a page. For example, the option

Sequence 1, 3, 2, repeat places one image on the first

page, three images on the second page, and two images

on the third page. Then the pattern repeats.

Pick and Arrange the Photo Album Photos
Click the Next Step button to move to the next frame of the

dialog box (Arrange Your Photos):

This step works just like the Simple Slide Show dialog box.

You can click the Add Photos button to open the Add Photos

dialog box and select the photos you want to use. You can also

use a photo again or remove a photo. Finally, you can use click

and drag to rearrange the thumbnails. As you can see on the

next page, the page on which the image will be placed is noted

in the upper-left corner of the image—this placement will change

as you rearrange the images.
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Organizer will warn you if your

pictures are small and thus won’t

print well. The dialog box at right is

your first warning in the Arrange

Your Photos frame.

In addition, Organizer tells you

which photos aren’t high enough

resolution to print well by placing a

triangular yellow warning icon on

the thumbnail, as you can see in the

images at right.

As with all the creations, if you selected a set of images before beginning the creation,

the thumbnails will be displayed when you reach step 2.
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Customize the Photo Album Pages
Click the Next Step button to advance to the next frame of

the dialog box (Customize), shown in Figure 25-5.

From the Customize panel, you can perform the

following tricks:

■ Move to a different page To pick any page in the

album, choose the page from the drop-down list at the

top-center of the dialog box. To advance to the next

page, click the right arrow button near the right edge.

To go back to the previous page, click the left-arrow

button near the left edge.

■ Move and resize the photos You can move and

resize the photos on the page. To move a photo, click

in the photo and drag it to a new location. To resize a

photo, click and drag one of the sizing handles in the

corners of the rectangle that appears when you click

in the image, as shown at left.
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25Printing more pictures on a page shrinks the images on that page, so even low-resolution

pictures might print okay at these smaller sizes. Thus, if you get the low resolution

warning, try moving the low resolution picture to a page with more pictures on it so it

will print smaller. The easiest way to do this is to increase the number of pictures on the page

using the Photos on This Page drop-down list discussed in the next section. You’ll just have to

experiment—and print a draft before sending the pages out to be printed professionally!

Photo Album Displays Images
in the Order You Specify

Getting the images in the right order is very important. The first image goes on the title page

(if you choose to use one). The title page contains only a single image, no matter how many

images you choose to place on other pages using the Photos per Page drop-down list. And if

you want to use the image on both the title page and some other page, you’ll need to click the

Use the Image Again button to create a duplicate of the image, then drag it to its position in

the list of thumbnails.
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■ Reset the images To return an image to its default

position and size, choose Reset Photo from the image

shortcut menu. To return all images to their default

position and size on the page, click the Reset Photos

button in the shortcut bar or choose Reset All Photos

from the image shortcut menu.
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Add free-form text
Return the photos to their
default location and size

Pick a page from the
drop-down list

Change the number of
photos on the page

Advance to
the next page

Double-click to modify a captionReturn to the previous page FIGURE 25-5 Arrange your
photos and add text with the
Customize panel of the Photo Album
Pages dialog box.

Some page layouts include borders. If you drag or

resize an image so that part of it falls outside the

border, that portion of the image won’t be visible.
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25■ Modify the page header If you chose to use headers,

you can modify the header text by double-clicking the

header (which is initially labeled “Double-click to

Insert Header”) or choosing Edit Text from the shortcut

menu. This opens the Header dialog box, shown in

Figure 25-6. Edit the text in the dialog box

and choose the font, effects, and size from

the drop-down lists across the top of the

dialog box. You can apply an underline or

strikethrough style from the two leftmost

buttons in the shortcut bar (just below the

drop-down menus), as well as apply left,

center, or right justification from the three

buttons in the center of the shortcut bar. Click

the Change the Text Orientation button to

switch the orientation between left-right and

up-down. Finally, to change the text color,

click the colored rectangle at the right end of

the shortcut bar.

■ Modify the page footer If you chose to use footers,

you can modify the footer text in exactly the same way

as modifying the page header.

■ Modify a photo caption To modify the text of a

photo caption, double-click the caption (or choose Edit

Text from the caption shortcut menu) and fill in the

Caption dialog box. This dialog box is identical to the

Header dialog box (shown in Figure 25-6) except that it

is missing the Apply to All Headers check box.

■ Move or size a text block To move a text block (such

as a caption, header, footer, or free-form text), click the

text to show the sizing rectangle, then move the mouse

inside the rectangle and click and drag the rectangle to

a new location. To change the size of the text rectangle,

click and drag one of the sizing handles, as shown at left.

To make all headers the same, select the Apply to All Headers check box.

FIGURE 25-6 Modify the properties
of the header text using the Header
dialog box.

Changing the caption for an image on a photo page does not affect the caption

associated with the photo in Organizer.
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■ Change the number of photos on the page To

change the number of photos on the page, select the

number of photos you want from the Photos on This

Page drop-down list in the upper-right corner. To return

to the number of photos that would be on the page

based on your original settings, choose Default.

■ Add free-form text to the page You can add

additional text boxes to the page by clicking the Add

Text button in the shortcut bar. This opens the Text

dialog box, which looks the same as the other text

dialog boxes. Make your modifications and click Done

to place the text on the page. As with captions, you

can delete, move, and size the text box.

Save the Photo Album Pages
Click Next Step to advance to the Save frame in the dialog box

(see Figure 25-7). Fill in the title for the album pages in the
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To return a text box to its default position and size, choose Reset Text Box from the text

box shortcut menu. To return all the text boxes to their default position and size on the

page, choose Reset All Text Boxes from a text box shortcut menu. You can also delete a

text box by choosing Delete Text Box from the text box shortcut menu.

FIGURE 25-7 Save your work
with the Save frame of the Create
Photo Album Pages.
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Album Pages Name field. If the photos you selected are not

from the current catalog but you’d like them included in the

current catalog, select the Show These Photos in My Photo

Browser When Finished check box.
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Any tags associated with the pictures you include in the photo album pages are also

attached to the photo album pages thumbnail.

Work with Saved Photo Album Pages

Once you’ve saved your Photo Album, the title page (or first page, if you didn’t use a title

page) appears as a thumbnail in the Photo Browser. To re-open the Photo Album Pages

creation and modify it, click the thumbnail and choose Edit from the thumbnail shortcut

menu or the Edit menu. This redisplays the photo album pages in the Creation dialog box,

ready for you to make any changes.

You can also select Share from the thumbnail shortcut menu or the Edit menu to re-open

the photo album pages at the Share frame in the dialog box. This makes it easy to share the

results again—or pick another way to share the photo album pages.

You can filter the contents of the Photo Browser to display just the images included in the

photo album pages by choosing Show Creation Items in Photo Browser from the thumbnail

shortcut menu or the Edit menu. When you are done viewing (and editing, if you like) the

images, click the Back to All

Photos button.

The last interesting way to re-

open the Photo Album is to pick

View from the shortcut menu.

This opens the photo album pages

as a simple, full-screen slide show

(see Figure 25-8). Use the

navigation controls that initially

appear in the upper-right corner

to view the pages or navigate

between them. You can also view

this slide show at any time while

you are building the album pages

by clicking the Full-screen Preview

button that appears in the Step 3:

Customize step.

FIGURE 25-8 View the photo album pages as a slide show.
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Share the Photo Album Pages
Click the Save button to move to the final frame of the dialog

box (Share), as shown in Figure 25-9. If you don’t want to share

your photo album pages, simply click the Done button. Otherwise,

to choose a method of sharing your pages, click one of the

buttons on the right side of the dialog box.

Create an Adobe Acrobat Document
To create an Adobe Acrobat document from the photo album

pages, click the Create a PDF button. From the resulting dialog

box, choose whether to optimize the result for viewing onscreen,

for printing, or use the full resolution of the images. Each option

sizes the photos for the appropriate use. The printing option

results in a larger file than the viewing onscreen option, and

the full resolution option results in the largest file of all. Once

you’ve picked the option you want, click OK, provide a filename

in the Export PDF As dialog box, and click Save.

To order your photo album pages (and other creations) online, click the Share Online

button to access the Adobe Ofoto web site and follow the prompts to build an address

book, specify the options, supply a credit card, and complete the order.

FIGURE 25-9 Choose one of the
buttons to decide how to share your
Photo Album Pages creation.
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Print the Album Pages
To print the photo album pages, click the Print button. This

simply opens the standard Print dialog box, where you can

select a printer, choose the print quality and number of copies,

and specify the range of pages to print. Click Print to send the

pages to the printer.

E-mail the Album Pages
To e-mail a set the photo album pages, click the E-mail button.

This opens the Attach Creation Items to E-mail dialog box:

From this dialog box, you can specify the attachment filename

and select the size and quality of the included images, just as you

did with the Create a PDF option. You can also enter a message

by typing it into the Message text box.

If you have added contacts to the Photoshop Elements

Contact book, they will appear in the Select Recipients portion

of the dialog box. To send an e-mail to one of the recipients,

select the check box alongside the name. You can also click the

Add Recipient button to present a dialog box where you can fill

in the information to add a recipient to the list.
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Select the Add to Contact Book check box in the Add a Recipient dialog box to

automatically add the recipient to the Contact Book.
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Click OK. Photoshop Elements creates an Adobe Acrobat

(PDF) document that includes your album pages. It then opens

your default e-mail application (Outlook Express in my case)

and creates an e-mail addressed to the recipients you selected.

It also attaches the PDF document to the e-mail. You can then

customize the message and subject line, and click Send to send

the e-mail on its way.

Design Your Own Greeting Cards
You can use your photos to create greeting cards for holidays,

events, and special occasions. To begin the process, choose

Card from the Creation Setup dialog box and click OK. This

opens the Create a Card dialog box in the first panel, Creation

Set-Up (see Figure 25-10).

FIGURE 25-10 Build a greeting
with the Create a Card creation
dialog box.

If the PDF document is large (over 1MB in size), you will get several warnings asking

if you are sure you want to send the document. This is because some e-mail providers

limit attachment sizes. In addition, if your recipient is using a slow Internet connection

(such as dial-up), it can take a long time for them to receive the e-mail.
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25Building a greeting card works very much like building

photo album pages, covered previously in this chapter. The first

step is to pick the style of the card from the scrolling list on the

right side of the dialog box. To proceed, click Next Step.

The next frame (Arrange Your Photos) enables you to Add

Photos, Use a Photo Again, or Remove a Photo, or rearrange the

order of the photos. The order of the photos establishes which

photo goes on the front of the card, and which one (if any) goes

inside. Then click Next Step to proceed.

The next frame (Customize) enables you to view the front

and inside of the card by selecting from the drop-down list or

clicking one of the arrow buttons to move back and forth between

the pages. You can size and position your photo; specify, size,

and position a text caption (on some card styles), and greeting;

and add free-form text. Again, all this works very much like the

Photo Album Pages dialog box. Click Next Step to proceed.

The next frame (Save) enables you to name the card so you

can save it. As with photo album pages, you can choose to add

any photos from the card that are not part of the current catalog.

Once you save the card and the thumbnail shows up in the Photo

Browser, the card thumbnail provides all the same options you

had with photo album pages.

The last frame (Share) provides the ability to share the card

by creating a PDF document, printing it, e-mailing it, or ordering

it printed online.

Postcards and Greeting
Cards are Very Similar

Building a postcard (choose Postcard from the Creation Setup dialog box) is identical in

every way to building a greeting card. Well, almost identical. The one exception is that

postcards only have a front—unlike greeting cards, they don’t have an inside. Thus, the

Customize step provides only the single page of the postcard, the front.
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Keep Track of Your Year
with Wall Calendars

The first time I ever saw images used outside of just printing

them, it was to create wall calendars. At that time, you had to

send your photographs to a company and pay a fair amount of

money to have them printed. Now, using Photoshop Elements

Organizer, you can use your photos in wall calendars and print

them yourself (or order them online).

To get started building a wall calendar, choose Wall

Calendar in the Creation Setup dialog box and click OK. This

opens the Create a Wall Calendar dialog box, showing the

Creation Set-Up frame (see Figure 25-11).

Like the photo album pages project (and others), the first

step is to pick a style from the list along the right side of the

dialog box and choose your print options. Of course, you’ll also

need to specify a month/year range for the calendar. Pick the

starting month and year from the Starting drop-down lists and
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FIGURE 25-11 Pick a calendar
style and specify the options for your
wall calendar.
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the ending month and year from the Ending drop-down lists.

Click Next Step to proceed to the Arrange Your Photos frame.

The Arrange Your Photos frame works identically to the

photo album pages—you can add and remove photos and

rearrange them. The order of the photos is important, as this

determines which photos get used for which month. In this view,

each photo is labeled with the month for which it will be used:

Click Next Step to proceed to the Customize frame.

As with photo album pages, the Customize frame enables you

to pick a page to work on, in this case a month in the calendar you

are creating. You can move and resize the image or the caption

and add free-form text. As you can see from Figure 25-12, the

calendar can look pretty good!
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You are not limited to just a one-year calendar. You can pick any range of dates (month/

year) for which to create a calendar.
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When you’re done customizing the pages in the calendar,

you can move on to the Save frame and the Share frame, which

have the same options as previously discussed.

Create a Web Photo Gallery
One of the slickest things you can do with your photos is to post

them on a web site. But what if you don’t know how to create

web pages, add thumbnails to them, and set up the links so that

people can view the full-sized images? Not to worry, the Web

Photo Gallery Creation takes care of all the messy details for

you. Some galleries consist of a customizable web page with

thumbnails of your images. A visitor to your site can click

a thumbnail to see the full-size image. The web page can display

the filename, title, and author. Other galleries display individual

photos full-size.

To get started, select Web Photo Gallery in the Creation

Setup dialog box and click OK. This opens the Adobe Web

Photo Gallery dialog box, as shown in Figure 25-13.
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FIGURE 25-12 The combination
of a picture and the calendar makes
for a useful and attractive creation!

P:\010Comp\HowTo8\805-5\web.vp
Friday, December 03, 2004 2:52:43 PM

Color profile: Generic CMYK printer profile
Composite  Default screen



Select the Photos to Use
The first step is to choose which photos you want to use. As

with other creations, any images you had selected when you

began building the web photo gallery appear in the scrolling list

on the left side of the dialog box. You can add more photos by

clicking the Add button to open the Add Photos dialog box and

choose the photos you want. You can also remove photos from

the list by selecting the photo and clicking the Remove button.

Specify the Site Style and Banner
The drop-down list at the top of the dialog box provides a list of

web photo gallery styles. Pick a style to preview the style in the

area just below the drop-down list.
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Click to add photos

Web photos are
shown here

Pick a gallery style
from this list

Specify the Banner
properties

FIGURE 25-13 Build a web
photo gallery to display your pictures
on the Web.
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To set up the basic information for the web site, type the

appropriate values into the fields in the Banner tab (also visible

in Figure 25-13). Set the path to the site folder where you will

save the web photo gallery by clicking the Browse button and

specifying the path in the Browse for Folders dialog box. The

selected path appears in the Path field. Enter the name of the

folder that will hold the actual web site in the site folder.

Set the Thumbnail Properties
Click the Thumbnails tab

to display the thumbnails

properties, shown at right.

The properties you can

set are

■ Size To set the size

of the thumbnails,

select a value from

the Thumbnail Size

drop-down list.

■ Include filename in

the caption To include the filename in the thumbnail

caption, select the Filename check box in the Captions

section of the dialog box.

■ Include photo caption in the caption To include

the photo caption in the thumbnail caption, select the

Caption check box in the Captions section of the dialog

box. Very few of the gallery styles allow you to include

the caption, but the Simple style and the Vertical Frame

style do.

I usually fill in the name of the site folder as the last step before I save. This is because

the web photo gallery changes as I design it, and I want the name of the site folder to

accurately represent the gallery contents.

Some gallery styles enable you to pick the font and size to use for the banner; others

use a preset font and size, and these drop-down lists are grayed out and unavailable.

P:\010Comp\HowTo8\805-5\web.vp
Friday, December 03, 2004 2:52:44 PM

Color profile: Generic CMYK printer profile
Composite  Default screen



CHAPTER 25: Build Creations with Your Photos 37

25■ Include the date in the caption To include the date

in the caption, select the Date check box in the Captions

section of the dialog box. Very few of the gallery styles

allow you to include the date, but the Simple style and

the Vertical Frame style do.

■ Font and Size Some gallery styles (such as Vertical

Frame) enable you to specify the font and size—pick

them from the Font drop-down list and the Size drop-

down list in the Captions section. If these properties are

grayed out, the gallery style uses a preset font and style

for any captions.

Set the Large Photos Properties
Click the Large Photos tab

to display the large photos

properties, shown at left.

This tab displays the

properties of the full-size

images that are either

displayed on a page or

are displayed when you

click a thumbnail (depending

on the gallery style).

If you wish, you can

resize the images so that they

are all approximately the same

size. To do so, select the Resize Photos check box and pick an

image size (Small, Medium, Large, or X-Large) from the drop-

down list. Larger photos take up more room and take longer

to download, so you should be careful about specifying big

images. You can also adjust the image quality. A low image

quality results in a smaller file, a high image quality uses

less compression and thus you get a larger file, which takes

longer to download from the Web. As with the thumbnail,

you can specify whether to include the filename, caption, and
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Some gallery styles, such as Classic and Dance, don’t use thumbnails at all, so there is

no point in configuring the Thumbnail tab!
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date in the large photo caption, as well as the font and size to

use. Again, only some gallery styles allow you to change the

font and size of the captions.

Set the Custom Colors
A few of the gallery styles

enable you to choose custom

colors for the background,

banner, text, active link, link,

and visited link. To set the

custom colors, click the Custom

Colors tab, shown here.

To set a color, click the

colored rectangle, pick the

color you want to use from

the Color dialog box, and

click OK.

Save Your Web Photo Gallery
Once you are done configuring your Adobe Web Photo Gallery,

click Save. The entire site is saved to the destination, including

thumbnails, the images (resized if you so chose), and the HTML

files. Once the Save is complete, the Web Photo Gallery

Browser opens so you can preview your site (see Figure 25-14).

If you chose a gallery that displays thumbnails, you can

view the image associated with the thumbnail by clicking it in

the Web Photo Gallery Browser.

Of course, the web pages are still located only on your hard

drive, so they can’t be seen on the Internet. You’ll still need to
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It is best not to change the color of the link (hyperlink), visited link (a link the

visitor has already clicked on), or the active link (a link the mouse is hovering

over). This is because people get used to getting cues from the color (such as a

purple link being one they’ve already visited), so changing the colors of these links could confuse

your web site visitors.

To preview the web photo gallery in your default browser, navigate to the destination

folder and open the folder with the same title as your gallery. Then double-click the

Index.html file.

P:\010Comp\HowTo8\805-5\web.vp
Friday, December 03, 2004 2:52:45 PM

Color profile: Generic CMYK printer profile
Composite  Default screen



upload the pages to your web site, using FTP or your web site

software (such as FrontPage or Dreamweaver). And don’t forget

to provide a link from a page in your web site to the photo

album pages (your web site software should help you with this).

Create a VCD with a Menu
The VCD with Menu creation enables you to burn multiple

slide shows onto a video CD and provides a menu that lists all

the slide shows. If you play the video CD in a DVD player

(most modern players will work), you can use the DVD player’s

remote control to pick the slide show from the menu and then

play the slide show.
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FIGURE 25-14 Preview your
web photo gallery in the Web Photo
Gallery Browser.
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To get started building a VCD with Menu, select VCD with

Menu from the Creation Setup dialog box and click OK to open

the Create a VCD with Menu dialog box (see Figure 25-15). As

with any other creations, any slide shows you have selected will

appear in the dialog box.
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Any Windows Media Video (WMV) files that you created with a setting of VCD NTSC

Output or VCD PAL Output (depending on what you set in the Video Options section)

will also appear in the dialog box with a little filmstrip icon in the upper-right corner.

Since WMV files do not have to be converted to WMV files before being burned to the video CD,

using WMV files is much faster.

Included VCD WMV file Included slide shows

Set video options for NTSC or PAL

FIGURE 25-15 Choose the slide
shows to include on the VCD and
burn it.
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To add more slide shows to the video CD, click the Add

Slide Shows button in the upper-left corner to open the

Add Slide Shows dialog box:

Simply select the check box alongside each slide show you

want to include and click OK.

When you are ready to burn your video CD, insert a blank

disc in the drive and click the Burn button. This converts regular

slide shows to WMV and writes all the files to the video CD.
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Be patient when creating a video CD. Even on my 3GHz Pentium 4 computer, it can

take quite a while to convert the slide shows to WMV and then burn them to the disc.
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